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Note: The SCC guides to MLA, APA, and Chicago all contain a similar format and layout. This continuity 

should help students work through each step of writing a research paper while also noting the different 

documentation style requirements for their course or field of study. Be careful to select the right style 

hand-out. 

 

We have endeavored to be as accurate as possible in the creation of this document. It is entirely possible, 

nonetheless, that the reader may find some errors. We ask that you email any corrections to 

btracy@southeast.edu. Please include the page where you found the error in the guide and the page or 

section number where you found the correction in the Publication Manual of the American Psychological 

Association 6
th
 ed., 2

nd
 printing. An update with corrections will be posted at the Writing Center home 

page. For questions about using APA style, please contact the Writing Center, (402) 437-2627 or 

writingcenter@southeast.edu. 
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Writing Research Papers  
Many courses at SCC require students to write research papers. These assignments ask students to 

research published information to help them not only expand their understanding and view of the topic, 

but also to provide evidence of critical thinking. Most importantly, remember that a research paper is not 

a pasting together of other people‘s writing, but rather a compilation and discussion of a student‘s own 

ideas, supported by other sources. Reliable, published sources lend credibility to writing and are a great 

way to support a writer’s ideas. However, it is important to remember that whenever you gather 

information from any source, you will need two things:   

1. a proper citation at the end of the sentence containing the quotation or paraphrase  

2. a corresponding entry in your reference list  

See the section ―Using Citations‖ for more details and specific situations. 

 

General Advice as You Begin 

 Start early. Even though the final paper‘s due date may seem far away, the research, drafting, 

and revision processes demand much time. Anticipate possible problems and setbacks by 

beginning early. 

 Be organized. Keep track of everything—this will save you time and work later on in the project. 

Many students organize with large file folders. Record the titles of books, magazines, journals; 

authors; and page range in one place. On your personal computer, create a folder to bookmark 

Internet sources and a file to store any articles that you have downloaded. You may also want to 

photocopy articles and print web sources. Keep track of where you found the sources that you 

reviewed. If you decide later that you want to take a second look at a source or double check a 

quotation, your notes or files will make it much easier to find the source.  

 Set personal deadlines. Even if your instructor does not assign deadlines for gathering research 

or turning in drafts, that does not mean that you cannot set your own. Create deadlines on an 

academic calendar, spreading them out enough so that you can realistically meet them. Some 

students find it useful to post these dates on a note that is visible to them every day, such as on a 

computer screen, a door, or a bathroom mirror. 

 Ask questions. If you are confused about the assignment in any way or are unsure of your topic 

or thesis statement, ask your instructor. Meet with your instructor during his or her posted office 

hours or schedule an appointment to discuss your project. 
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 Create a weekly writing schedule. It is useful to schedule a time to work in the library or at 

home. Build your project into your weekly schedule. If you have half an hour between classes or 

before work, research online, work on the reference list, or submit your paper to Smarthinking. 

 Visit the Writing Center throughout the writing process. If you live in or near Lincoln, visit 

the Writing Center as often as you can with revised drafts. You can either visit the Center in 

person or upload your file to Smarthinking.com, an online tutoring service available to SCC 

students free of charge. Smarthinking is particularly helpful if you do not live in Lincoln or if you 

are an online student.  

o The Writing Center is open Monday through Thursday, 9:00am-7:00pm, and Friday, 

9:00am-3:00pm, and is located in the lower section of the Learning Resource Center 

(LRC) at the 8800 ‗O‘ St. SCC campus in Lincoln. Call the Writing Center at (402) 

437-2627 for current hours, to ask a brief writing question, or to make an 

appointment. You may walk in or schedule a 30-minute appointment.  

o Tutoring is also available at the downtown Lincoln Energy Square (ESQ) campus by 

appointment. Email us at writingcenter@southeast.edu to schedule an ESQ 

appointment.  

All services are free to current SCC students. Please bring a current SCC student ID. Tutors 

help students at all stages of the writing process—from choosing a topic or research question 

to polishing a final draft, whether in person or on Smarthinking.com. 

To submit your essay on Smarthinking.com for an electronic tutorial: 

o Save your file in Rich Text Format (RTF), remove any graphics or illustrations, and 

log onto www.smarthinking.com (Note: the address has only one ―t‖). Directions 

regarding your username and password are available on the Writing Center website. 

To access, go to: http://my.southeast.edu  Student Links  SCC Writing Center (in 

the middle column). 

o Tutors will read your work (usually within 48 hours) and return the draft with a 

report. Feel free to call or drop by the Writing Center if you have questions about 

Smarthinking.com or your report from Smarthinking. 

o For log-in problems, students, not their instructors, should call 402-437-2627. The 

staff at the Writing Center can help students with most log-in problems but will need 

to talk directly to the student.  

o Whether you see a tutor in the center or use Smarthinking, visit or submit your 

essay at least five days before it is due to allow you time to use what you learned 
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from your tutor and revise your paper. Note that Smarthinking can take up to 48 

hours for a response to your essay. 

 

 

Formulating the Research Question  

Beginning the research stage can be a daunting experience. Be sure to discuss any questions you may 

have about your topic with your instructor early in the process. He or she may have valuable suggestions 

about possible sources or databases that may be useful (which may save you time, too!). Also, your 

instructor may give you feedback about your topic‘s focus. If you are assigned a seven-page research 

essay on sports psychology, for example, you will need a focused research question to guide your 

research. In this case, the topic of ―sports psychology‖ is too broad. Make sure that your topic‘s focus is 

appropriate for the assigned page-length. Count on the general rule that the shorter the essay length, the 

more focused and specific your question should be.  

 

Focusing your research question will also help you narrow your research. If the topic is the role sports 

psychology plays in Major League Baseball, then the project becomes much more grounded, and you can 

immediately construct a list of useful sources that would narrow the project from a broad, general search 

of thousands of references to a much smaller list. 

 

 

 

 

Broad    
Topic 

• Sports Psychology

Focus

• The symptoms of disorders that sports psychologists treat

• The history of sports psychology

• Professional sports

More    
Focus

• Focused research question: What role does sports 
psychology play in Major League Baseball?
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Gathering Research 

Once you have a focused research question, it‘s time to begin researching. There are a number of places 

to start: 

 Library databases 

 Traditional sources: books/magazines/newspapers 

 Internet searches 

 

Give yourself enough time to visit the library in search of information on your topic. While there are 

many reliable sources that you can access electronically, libraries still contain endless materials that are 

not available through a general Internet search. SCC students have borrowing privileges at the SCC 

Library (LRC).  In addition, with your SCC ID or a Nebraska driver‘s license, you have privileges at the 

University of Nebraska-Lincoln‘s Love Library. Also, check your city library for borrowing policies. Talk 

to the reference librarians in the LRC about your paper and ask for suggestions. SCC‘s library has 

excellent reference librarians available to answer questions about your research. Be sure to follow the 

advice mentioned earlier about organizing your research.  

 

Evaluating Sources 

When reviewing the possible sources for your paper, consider reliability and acceptability. Just because 

something was published doesn‘t make it a reliable, truthful, or up-to-date source. Anyone can publish, so 

use critical thinking when evaluating and selecting any type of source, whether online or in print. If you 

are writing about a medical issue, for example, a book published in 1962 is probably less credible than 

one published this month. If a source is published by Harvard University Press, it is more likely to have 

been reviewed by credible leaders in the field than a posting on a private individual‘s webpage. 

 

Reviewing Sources: Frequently Asked Questions 

What types of sources are the best to use? 

 Scholarly journals published by universities, research institutions, and professional organizations 

tend to be more credible than popular magazines (Ormondroyd, 2004). Journals list the sources 

used in their articles, which you may want to find and read for your own research. In addition, 

books published by universities or well-known presses are usually credible because they are more 

likely to be carefully scrutinized by a professional review committee prior to publication. 
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What do I need to know about the author? 

 Sometimes the author may be an organization, such as the American Heart Association. Many 

times, the author is an individual or a group of individuals. To evaluate the author‘s reliability, 

read the author‘s credentials, such as degrees, professional memberships or associations, other 

publications, occupation, and/or research experience (Ormondroyd, 2004).  

What’s so important about the year of publication? 

 The information on many topics, such as medicine or technology, changes rapidly. For 

comprehensive, credible research, avoid using outdated sources (Ormondroyd, 2004). Ask your 

instructor for guidelines to publication dates regarding your topic. 

What type of sources should I avoid? 

 Beware of writing that contains logical errors, bias, propaganda, and unsupported opinions. Look 

for comprehensive, well-researched, objective writing. Ask yourself if the facts are verifiable and 

based on sufficient evidence. Carefully review any ideas that radically vary from other sources on 

the same topic (Ormondroyd, 2004).  

What about blogs, Wikipedia, Twitter, etc.? 

 Many high-profile blogs are becoming more accepted as valid sources. When citing a blog entry, 

it is critical to know the author and his or her credentials and then evaluate the quality of the 

source. If the source is valid, make sure you build this credibility into the setup for your 

discussion of this source. For instance: 

Many bloggers such as Name of Source (2003), who is a law professor writing the 

professional blog, Blog Title, have suggested that the law should be repealed. 

“Quote what this blogger said here.”  

 Most entries in Wikipedia can be edited by anyone, so again pay close attention to who you are 

quoting and his/her credentials. On the other hand, many of the entries list sources that you might 

find useful and reliable. 

 More educational and professional organizations are publishing on sites such as Twitter. Search 

the web for ―Top 100 Edu Tweeters‖ to read about what is available.  

 Carefully review this section on ―Evaluating Sources‖ and apply these principles to all of your 

online research. 

 

When in doubt, ask your instructor if blogs, wikis, Twitter, or similar electronic media 

are acceptable forms of support in your specific writing assignment.  
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Are web pages and online library sources the same thing? 

 No. Libraries subscribe to database services that provide an electronic version of previously 

published articles from print periodicals. These online databases, such as First Search and 

EBSCO, provide reviewed articles. Web search results from Google and other search engines 

should be scrutinized much more closely than library print articles or online database articles. 

Unless your instructor asks you to do so, you should never rely solely on general web page 

sources, and in most cases these types of sources should be avoided. However, Google now offers 

a feature called Google Scholar, which offers academic articles, books, law briefs, etc. 

 

Is the web page I’m using credible? 

 Proceed with caution. A page may be credible if it is associated with a known, reliable 

organization, such as a national association or university (look for ―.edu,‖ ―.gov,‖ or ―.org‖ at the 

end of the web address). To find out, look at the URL (Internet address) for a link to a homepage. 

Also look for bias. For example, an ―.org‖ site will typically represent a nonprofit organization, 

but that organization may have a specific political or ethical slant that you will want to evaluate 

before using this source as evidence. If your point is to discuss how the Arthritis Foundation 

views water therapy, then their web page is a good place to go. If you want to argue that water 

therapy is the best treatment, then you will want to include a variety of sources that discuss both 

the pros and cons.  

 

When looking at ―.edu‖ sites, be wary of classroom pages. While these may be associated with a 

university, the essays are often written by other students who are just beginning to learn about 

their topics. Avoid using their content as evidence, but take advantage of their reference lists, 

which may include or even link you to valuable sources that you can use. 
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Avoiding Plagiarism 

What is Plagiarism? 

Plagiarism is taking personal credit for someone else‘s ideas or work. The APA (2010) says this about 

plagiarism:  ―The key element of this principal is that authors do not present the work of another as if it 

were their own work. This can extend to ideas as well as written words‖ (1.10).
1
 This includes both 

copying someone else‘s work and turning in work a friend does for you as your own original work. The 

APA (2010) goes on to state that even modeling one‘s work after another‘s or using another‘s rationale 

requires credit given to the original source (1.10). Search the Internet for Simon Fraser‘s ―Plagiarism 

Pretest.‖ You will be surprised by many of the answers. 

 

Types of Plagiarism 

Plagiarism comes in many forms. Sometimes it‘s deliberate, and sometimes it‘s accidental. Sometimes 

students don‘t take good notes about their sources, or they forget to give credit to a source by using a 

citation. Many plagiarism-related mistakes occur because students are unaware of the rules or 

misunderstand the terminology associated with writing and plagiarism. However, just like backing your 

car into a light pole, something you didn‘t mean to do, accidents have consequences. So you want to 

proceed with caution. 

 

 

 

 

 

 

Put simply, if you hear or read something and put the words or ideas in your paper, you must cite it. 

Sometimes students will deliberately retype a published article or copy an article from the Internet and 

pass it off as their own work. Others copy and paste several sources together and call it their own. APA 

identifies something called ―self–plagiarism‖ in which the writer presents her/his own previous work as 

new scholarship without good reason AND without reference to the original work (2010, 1.10). This 

means that turning in work you did for a previous class as new work for a different class is also unethical. 

                                                           
1 ―APA‖ throughout this document refers to the Publication Manual of the American Psychological Association. Because APA 

periodically issues new editions, the editor will use section numbers when referring to content found in the APA rather than the 

APA format of using page numbers (as is standard practice for referencing such a manual). All other documentation will model 

the APA style. 

Even accidental 

plagiarism can have 

serious consequences. 
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You will want to discuss with your instructor any reuse of your previous research, writing, or essays in 

your current assignments before writing your paper.  

 

The Internet contains endless images, photographs, charts, and other visual materials that you might want 

to include in your presentation or essay. These are all copyrighted material. Sometimes these materials 

cannot be used at all. In all cases, they must be cited. Even if you discuss the image or the meaning of the 

chart, you must cite it. Discuss these with your instructor for further guidance.  

 

Regardless of whether plagiarism is intentional or accidental, the student could fail the class or be 

dismissed from the college. Students should be familiar with SCC‘s policy on plagiarism. It‘s important 

to remember that just as technology has made it easier for students to buy or copy papers from the 

Internet, technology has made it equally simple for instructors to detect plagiarism. Most instructors are 

skilled at identifying plagiarism and locating the original source. If you are tempted to plagiarize because 

you are unable to handle your workload, don‘t.  

 

Talk to your instructor and let him/her know that you want to do a good job on your paper and 

discuss any possible arrangements, such as turning in the essay late for a point deduction or even 

extending the deadline. Extensions and other allowances are entirely up to your instructor, so you may 

not always receive the option for alternative arrangements. However, even a failing grade in one class is 

better than the serious consequences for academic dishonesty (like being expelled from school). 

 

Why Should I Use Citations? 

There are three notable reasons why citations must be used in paper writing. The first reason has to do 

with intellectual property. People who think, research, and write for a living on the work they do, just as 

an artist owns the images he/she paints, even after he/she sells a painting. When academics or artists do 

something original, it is their intellectual property. For someone else to use their ideas, words, or research 

without giving them credit is equal to theft. If you don‘t give proper credit to your sources, you are guilty 

of intellectual theft, more generally called plagiarism. 

 

The second reason for using citations has to do with readers, who often become interested in references 

they come across in their reading. Upon reading your essay, they may want to know more about a 

particular source you used. Therefore, citing your sources is not only the fair and honest thing to do (in 

respect to the original authors), but it is also a courtesy to your readers. When readers come across 

something in your writing that they want to know more about, they can use your citation to direct 
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them to the corresponding entry on your reference list. From there, they will have all the information 

they need to gain access to the original source.  

 

Finally, citing your sources gives you credibility because it lets your readers know that your position is 

supported by research and experts in the field. 

 

Southeast Community College Policy on Plagiarism and Academic Dishonesty 

The SCC pamphlet on Academic Integrity (available from the Dean of Student Services) states: 

―Cheating, plagiarizing, or fabricating research are particularly reprehensible in a community dedicated to 

the advancement and pursuit of knowledge.‖ It goes on to provide some examples of academic 

dishonesty: 

 Cheating: using or attempting to use unauthorized materials for one‘s own academic benefit. 

 Plagiarism: intentionally [or unintentionally] presenting as one‘s own work the ideas, words, 

or information of another without citing the reference. 

 Fabrication/Falsification: inventing or knowingly altering information. 

 Facilitating Academic Misconduct: assisting another individual in committing actions 

considered academically dishonest. (Academic Integrity, 2006) 

The SCC pamphlet on academic integrity also explains the consequences of academically dishonest 

behavior: ―Violation of this policy will be reported to Student Services and may result in the following 

sanctions‖: 

 A grade of ―U‖ (unsatisfactory) for the exam, paper, or course. 

 Disciplinary warning or probations notice. 

 Suspension. 

 Expulsion. (Academic Integrity, 2006) 

Also note, as mentioned above, that reusing a paper which you wrote yourself in another class is 

considered academic dishonesty. Be sure to discuss any questions about this with your instructor before 

turning in work. 

 

A Note on Plagiarism and the Internet 

Faculty are fully conscious of the endless resources for student plagiarism. Students can find sites that aid 

in cheating and provide downloadable essays on the Internet. If you search for ―free essays,‖ you will 

receive thousands of pages that offer pre-written essays on almost any subject imaginable. However, 

copying whole essays or pasting together passages of essays is plagiarism. Clearly, if this guide tells you 
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how cheating can be done, then faculty are well aware that some students make use of these sites. 

It‘s very easy to do, and some students tend to do it when they are feeling stressed about getting all their 

work done or feel concerned about grades. Chances are, students who plagiarize will get caught, and this 

will only heighten the anxiety about passing the course. SCC‘s faculty are very serious about plagiarism, 

so students should familiarize themselves with SCC‘s policy on plagiarism. Bottom line: Don’t do it. 

Plan your time well and work with the reference librarians and the Writing Center early to remove this 

pressure to take short cuts. 

 

To enable students to check for plagiarism, SCC subscribes to Turnitin.com, which helps detect some 

types of plagiarism errors in student work. To use Turnitin.com, ask your instructor for an access code. 

Instructors may set up an account for each of their classes. They can get the instructions to do so from the 

Writing Center. Ask you instructor if he/she has done so and if you may submit your paper as a self 

check. Your instructor may also require you to use Turnitin.com for your assignments and/or check your 

papers him/herself. However, you will gain a great deal from reviewing your papers for plagiarism before 

you turn them in. If you need help, you can always visit the Writing Center. 

 

Tools to Avoid Plagiarism 

First familiarize yourself with some of the basic terms associated with writing and plagiarism. The best 

way to avoid plagiarism is to learn how to properly use direct quotes, paraphrasing, summarizing, 

citations, and the reference list. 

 

 Direct Quotes: A direct quote is a word-for-word replication of what someone else has written or 

said. Place direct quotes in quotation marks. When using a direct quote, be sure to copy every 

word exactly as it was said or written. After each direct quote, use a citation. See ―Using 

Citations.‖ 

 

 Paraphrasing and Summarizing: The difference between paraphrasing and summarizing is 

subtle, and the words are often used interchangeably.  

o Paraphrasing entails taking something that someone else said or wrote and putting it 

into your own words. The Online Writing Lab (OWL) at Purdue University explains 

paraphrasing as ―putting a passage from source material into your own words. . . . 

Paraphrased material is usually shorter than the original passage, taking a somewhat 

broader segment of the source and condensing it slightly‖ (Driscoll & Brizee, 2008, 

―What Are the Differences‖ para. 3). Paraphrasing provides an excellent way to restate 
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your source‘s ideas in a style and language that fits your writing style and intended 

audience.  

o Summarizing, on the other hand, concentrates only on the main points of a source. The 

Purdue OWL explains summarizing as ―putting the main idea(s) into your own words, 

including only the main point(s)‖ (Driscoll & Brizee, 2008, ―What Are the Differences‖ 

para. 4). The definitions of paraphrasing and summarizing are similar, and you must 

approach both in the same way: if you didn‘t originally think of the idea, no matter how 

much you rephrased it, cite it! 

 

It is also important to note that changing one or two words of a sentence 

is not the same as ―putting it into your own words.‖ Writers must 

significantly alter the construction of the sentence when 

summarizing and paraphrasing. 

 

 Citations: A citation is the information in parentheses found at the end of a sentence in which 

outside sources were used. The citation tells the reader about the source. It includes information 

about the author, the year of publication, and the page(s) on which the information can be found. 

There are different ways to cite different sources, so rely on this guide and the APA Manual for 

proper procedures.  

 

 Reference List: The reference list is an alphabetical listing of all the sources used in a paper, and 

it is found at the end of the document. APA style has detailed rules regarding how various types 

of entries are recorded and what type of information is required. Spend plenty of time with this 

guide and the Publication Manual of the APA to learn how to create the reference list. 
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Introduction to APA 

The Southeast Community College Writing Center has compiled this guide to provide a general, easy-to-

use reference for what is required in an APA style essay. The most inclusive source for APA style 

questions is the current edition of the Publication Manual of the American Psychological Association, 

Sixth Edition, second printing (referred to as the APA here),  but this guide is a useful starting point for 

students completing academic writing that requires the use of APA style.
2
 The SCC Writing Center also 

provides shorter hand-outs for various aspects of using sources. Please stop by the center or check our 

web page, which is located on the student links page at my.southeast.edu, or can be found by the 

following path: www.southeast.edu  Quicklinks  Student Services  Tutoring. 

 

Although APA style is widely known and used on a scholarly level, other formatting styles exist. It is 

important to realize that APA style is not the style for all college and academic writing, but that there are 

other styles used for various other college departments and courses: 

 Social Science courses require the use of the APA (American Psychological Association) style.  

 MLA (Modern Language Association) style is often associated with English and other humanities 

classes. 

 History and political science courses often require students to follow the Chicago Manual of 

Style.  

 Your instructor may give you specific instructions on how to cite your sources. 

Whatever method your instructor assigns, it is important to be as careful as possible to be accurate and 

detailed when applying the style to your academic papers. As you will see with APA style, the placement 

of periods, commas, and colons all count. 

                                                           
2 The APA 6th ed., 1st printing contains several errors. To learn about those errors and what to do if you bought a new APA 6th ed. 

1st printing, go to the APA web site: http://www.apastyle.org  For a free online tutorial and more information on using APA, go 

to http://flash1r.apa.org/apastyle/basics/index.htm 
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APA Citations 

Overview  

APA uses the author-date method for references cited in the text, which means you give both the author‘s 

last name and the year of publication in the text. These in-text citations correspond to the reference list.  

The reference list alphabetically lists all sources used to write your paper or presentation. Everything in 

your essay must have an entry on your reference list (APA, 2010, 6.10). Together, citations and the 

reference list record the books, journals, and other sources that you quote/paraphrase and cite in your text. 

 

Citations within your writing alert readers that an outside source has been used. In the example below, 

the signal phrase ―according to Cohen,‖ combined with the year and page number tells readers that the 

previous quote came from that source and alerts them to the corresponding entry on the reference list. 

Note that the page number is indicated by ―p.‖ before the number.  

 

According to Cohen (2009), “Homelessness exposes children to a constellation of 

risks and hardships during crucial early stages in their development” (p. 7). 

 

 

The reference list is the last page of a paper and alphabetically lists all the sources cited. The sources 

included on the reference list provide much more information that readers can use to find the source 

themselves. Listed below is an example of the reference list entry that corresponds to the previous 

citation: 

 

Cohen, A. (2009, July). Child homelessness on the rise. Futurist, 43(4), 4-16.    

      

This guide includes tips to using both citations and the reference list. For more information, continue 

reading ―Using Citations‖ and ―Writing the Reference List.‖ 

 

 

 

 

 

 

Citation 

Reference 

list 
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Framing Quotes and Paraphrases 

There are several ways you can incorporate outside information into your papers. In this section, you will 

learn how writers use direct quotes and paraphrasing to integrate useful information into their writing 

and how they correctly cite the information they use.  

 

 

 

 

 

 

 

 

 

 

 

 

 

There are different ways to show your reader that the information being read comes from an outside 

source: 

 

Framing Paraphrases and Quotes: 

 When you introduce your quote with a signal phrase, it alerts your reader that it is no longer you 

talking, but a source. For example: 

According to Smith (2008), 

Smith (2008) argued, 

 Your signal phrase can also include information about the author: 

Smith (2008), Director of the YWCA, explained, 

 If your source does not contain the name of the author, use the title of the article instead (do not 

use the name of the journal, newspaper, website, etc.). Afterward, you can refer to the writer as 

―the author‖ as long as it is clear to your readers which source you mean: 

According to “No Time for Play,” . . . 

The study found . . . 

One source found that, . . . 

 Signal phrases are written in the past tense (APA, 2010, 3.18). 

Direct Quote 

A word-for-word replication of 

something someone has written or 

said, indicated by quotation marks.  

As Booth, Sullivan, Koegel, 

and Burnam (2002) demonstrated, 

homeless persons suffering from 

substance abuse issues face “many 

vulnerabilities beyond their substance 

dependence that should be dealt with 

in treatment or other service settings 

before lasting housing can be 

achieved” (p. 430). 

Paraphrase 

Taking something that someone else 

said or wrote and putting it into your 

own words. 

Booth, Sullivan, Koegel, and Burnam 

(2002) reported that homeless 

individuals with substance abuse 

issues face many other hurdles in 

their recovery that can complicate the 

process of finding long-term housing 

(p. 430).  
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Sample Signal Phrases 

The following table suggests words you might use for signal phrases. Remember to only use a signal 

phrase that fits with the context of your essay; for example, do not write ―Smith argued‖ if Smith did not 

argue a point but rather observed it or explained it. 

 

According to Explained Reported 

Advised Found Revealed 

Argued Illustrated Said 

As explained by Instructed Showed 

As reported by Observed Suggested 

Believed Pointed out Stated 

Demonstrated Presented Warned 

Discovered Recommended Wrote 

Emphasized Related  

 

Closing the Quotation: 

When using a signal phrase that includes the author and year of a borrowed idea or direct quotation, 

simply place the page number where the material can be found in a set of parentheses and add a period. 

Do not put this at the end of the paragraph. Place it at the end of the quotation, even if it is mid-sentence. 

 

As Jones (2007) found, “Ninety percent of drunk drivers were arrested after 10 p.m.” (p. 43).  

 

Signal phrase  Year of   Exact quote/     Page where  

   Publication  paraphrased idea  the info was found 

 

According to Smith (2009), Anthropology is a very diverse field of study (p. 64). 

 

While the previous examples (called ―framing‖) are the clearest ways to introduce a quote, sometimes the 

signal phrase is difficult to work into the wording of your writing. In such a case, you can cite the source 

without a signal phrase by placing in parentheses the author‘s name, the year, and the page number 

following the quotation or paraphrased information: 
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Psychology is a very immersive field of study (Smith, 2008, p. 64). 

The study found that “cats are smarter than dogs” (Jones, 2009, p. 103). 

 

 

 

 

 

 

 

Long (Block) Quotes  

Sometimes, you may need to quote a longer passage of text in a research essay. Long quotes should only 

be used when the full length and exact quote are essential to your main idea.  Also, using too many long 

quotes looks like you are trying to make a short essay appear longer. Handle quotes of 40 or more words 

in the following style: 

 

 Indent the quote ½ inch, or about 10 spaces from the left side of the page (See ―Using Microsoft 

Word 2007 to Format APA Essays‖ at the back of this packet); 

 Double space; 

 Do not use quotation marks (the indentation indicates that this is a quote); 

 The period comes before the citation, which is different than a shorter quote or paraphrase 

citation. (APA, 2010, 6.03) 

 

In the following example of a long quote, note how the sentence prior to the quote leads the reader 

into the quote: 

According to a recent case, television may have made a positive impact: 

Authorities were shocked when 50 cases of child abuse occurred in just one day. In each case, a 

close family member had perpetrated the crime. There was speculation that a television special 

had prompted viewers to report instances where there was known or suspected abuse. (Young, 

1999, p. 26) 

As this study showed, rather than the expected negative impact of causing people to act violently, the 

television special caused people to take action against abuse. The high number of abuse reports filed 

following the television program‘s airing was too dramatic to be coincidental, and it clearly demonstrated 

that the special moved viewers to be advocates for others who did not have the ability to report or stop 

their own abuse.   

Sometimes students feel more comfortable quoting from all his/her sources 

because it reflects the amount of work he/she accomplished at the research 

stage. Over-quoting from one‘s sources, however, washes out the student‘s 

voice and thesis statement because so many different positions and voices are 

introduced that the student‘s main idea gets ―lost‖ among his/her sources. 
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Citations for Internet Sources 

Library databases often provide a ―picture‖ of the entire article in PDF form. These will show you the 

original page numbers, so you can use the same procedure as above.  

 

For other formats or web pages, there may not be a page number visible on the screen. Do not use the 

page numbers generated by your printer. First look to see if the document provides printed paragraph 

numbers; if so, use those instead of page numbers with the abbreviation ―para.‖ instead of ―p.‖ If the 

Internet source does not provide page or paragraph numbers, first look for any section breaks on the page, 

usually in the form of section headings. Use this as a landmark and then count the paragraphs from that 

heading. If the heading were ―Why Use the Writing Center,‖ and you want to quote the 4
th
 paragraph, 

then you will use those two bits of information to replace the usual use of a page number. So putting this 

all together looks like this: 

 

Using the Writing Center long before deadlines increases the quality of your essays (Smith, 2009, 

“Why Use the Writing Center,” para. 4).  

 

If the Internet source doesn‘t have an author or authorial organization, then you can use the title of the 

web page (note: this is the individual page, not the whole website) in your signal phrase. Do NOT include 

the web address: 

 

According to “Ten Steps to Improve Student Writing,” (2009), using the Writing Center long 

before deadlines increases the quality of your essays (“Why Use the Writing Center,” para. 4). 

 

 

 Be sure to follow up a long quote with focused 

discussion, as demonstrated above. What idea 

does the author suggest, and how does this point 

advance your thesis/ideas? Do not move onto a 

new point/topic without first ―unpacking‖ some 

of the ideas in the long quote. That is, do not 

rely on the reader to understand how the long 

quote reflects your point; rather, tell the reader 

how the passage fits into your larger point. 
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Tips for Paraphrasing and Balancing Research  

 Use paraphrasing whenever you can. Your writing will be clearer if you paraphrase your 

sources instead of forcing others‘ writing to fit your style. 

 Never write an entire paragraph containing only ideas from another source. You must 

always interpret your reference‘s ideas and explain how they support your thesis. 

 Always begin and end a paragraph with your own ideas; otherwise, you lose your voice 

and credibility, and you will not have a transition between paragraph ideas. 

 Always make your own ideas the majority of your essay. Think of quotes and paraphrases 

as extra information that helps build your own ideas. 
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Formatting the APA Essay 

 

Whether you are writing a research paper or a personal essay, if your instructor requires APA style, then 

you will be expected to format according to the rules. The following section summarizes the formatting 

rules. See the APA website or the Writing Center for a sample essay, which illustrates a finished APA 

style essay. Also see ―Using Microsoft Word 2007 to Format APA Essays‖ in a later section of this guide. 

 

Font and Paper 

 Use a standard, easy-to-read 11- or 12-point font such as Times New Roman, Arial, or Calibri. 

(Your instructor may require a specific font). Use the same font throughout the entire paper. 

 Use only white 8 ½‖ x 11‖ paper of good quality. 

 Use only one side of the paper. 

 Always keep both a printed copy and an electronic copy of your paper. 

 

Margins 

 Leave one inch margins at the top, bottom, and both sides of the paper. You may need to reset 

the default margins in your word processing software. 

 Align all text to the left. Do not justify the right margins. 

 Indent the first word of each new paragraph ½ inch (or ten spaces) from the left margin. 

  

1” 
 
  
 
 
 
1”               1” 

 
 
 

 
 
 
 

1” 
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Spacing 

 Papers must be double spaced, including quotations, headings, and the reference list. Single 

spacing is never used in the body of an APA essay. 

 Footnotes and explanatory captions for tables and figures are single spaced (APA, 2010, 5.16).  

 

Title Page 

 The title page has the following elements: a running head and page number in the header; and the 

title, author byline, and institutional affiliation (school name) on the main part of the page. 

 Running head: The running head should be an abbreviated version of the title, not your name. 

Type the running head flush left in the header of the title page. Type ―Running Head:‖ using 

regular upper and lowercase letters and the abbreviated title in all uppercase letters (as pictured 

below). Do not exceed 50 letters, including punctuation and spaces. Insert the page number flush 

right. This line will appear on all pages of your document (APA, 2010, 8.03 & Fig. 2.1). 

 Title: Type the title in upper and lowercase letters, centered between the left and right margins, 

positioned in the upper half of the page. If the title is more than two lines, double-space between 

the lines (and all other lines). 

 

For example: 

 

               Running Head: HOMELESS POPULATION AND MENTAL                 1                                                              

 

      

 

    

           The Homeless Population  

           and Mental Health Care 

           Bill Smith 

             Southeast Community College 

  

 

                                

See the ―Using Microsoft Word‖ section at the end of this document for more help with the title page. 
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Writing the Reference List 

Citations can‘t, by themselves, tell your readers all the information they may want to know. That‘s where 

the reference list becomes useful. Every source that you mention within your essay must be recorded in 

your reference list. This guide offers plenty of information about the reference list, but you may also find 

it useful to review the Publication Manual of the APA.  

 

For readers to easily and successfully use the reference list, the entries must match the source used and 

cited in your essay. For example: 

 

According to Nickens (2008), visitors to Shenandoah State Park in 2007 limited their view of the 

park to what could be seen from a car (p. 640).  

 

If a reader were to look up this source on the reference list, then he/she would look down the list of 

authors (which is alphabetized) and find ―Nickens.‖ Many web pages do not provide an author, so match 

the citation with the first piece of information—usually the article title—that comes in the reference list. 

One of the goals of the APA style is to make it easy for readers to find information quickly and 

efficiently.  

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 Running Head: APA RESEARCH SAMPLE                         2 

 

Sample text. Sample text. Sample text. Sample text. Sample 

text. Sample text. Sample text. Sample text. Sample text. 

Sample text. Sample text. Sample text. Sample text. Sample 

text. Sample text. Sample text. Sample text. Sample text. 

Sample text. Sample text. Sample text. Sample text. Sample 

text. Sample text. (Young and Smith 2010) Sample text. Sample 

text. Sample text.   

 Hays (2009) Sample text. Sample text. Sample text. 

Sample text. Sample text. Sample text. Sample text. Sample 

text. Sample text. Sample text. Sample text. Sample text. 

Sample text. Sample text. Sample text. Sample text. Sample 

text. Sample text. Sample text. Sample text. Sample text. 

Sample text. Sample text. Sample text. Sample text. Sample 

text. Sample text. Sample text.  

Running Head: APA RESEARCH SAMPLE                     12 

 

References 

 

Falluga, D. (Nov. 2003).Guide to literary and critical 

theory. Retrieved from http://www.cla.purdue.edu/ 

english/theory. 

Hays, S. (2009). Lorem ipsum. New York: Feugait Press. 

Miller, S. (2009). Untold stories. Madison: U Wisconsin 

Press.  

Young, P. & Smith, D. (2010). Knowing your stuff: How to 

show confidence in the face of intimidating 

circumstances. London: Cambridge Press. 

 

The Reference list acts like a road map to the essay,  

clearly showing where each source was found. 
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The Reference List: Frequently Asked Questions 
 

In what order should my sources appear? 

All sources on the reference list should be listed alphabetically. Use the first word of sources to 

determine which appears first, second, third, and so on. For example, if the author of one source 

is ―Smith,‖ then the source should appear alphabetically by ―S.‖ If your source has no author but 

a title, then use the first letter of the title to determine where it should appear. Titles that start with 

articles (―a,‖ ―an,‖ or ―the‖) are alphabetized by the second word in the title—never alphabetize 

by the articles ―a,‖ ―an,‖ or ―the,‖ although you still include that word when writing the title. 

Is my reference list a new document? 

No. Your reference list is a new page, but not a new document. To create a new page, place your 

cursor at the end of your document. On the ―Insert‖ tab, select ―Page Break‖ to begin your 

reference list on a new page. 

How do I title my reference list? 

At the top of the page you are using for your reference list, center your text and type References 

in the same font type and size as the rest of your paper (but do not bold the word). 

Is my reference list supposed to be double spaced? 

Yes, double space the entire page. Do not add extra spaces between the heading and the first entry 

or between entries. 

Do I number the sources in my reference list? 

No. List the sources alphabetically. Remember, do not alphabetize by articles (―a,‖ ―an,‖ and 

―the‖). 

Should I number the pages of my reference list? 

 Yes. Continue page numbers from the title page until the end of the reference list. 

 

Organizing Each Source 

Each type of source requires slightly different information. For example, books are recorded differently 

than online journals, and websites are noted differently than films. Now that you have an idea of how to 

format the reference list, you can move on to how to organize each source. Since APA format is particular 

about structuring citations, things can seem complicated. Don‘t be afraid to consult this guide, the 

Publication Manual of the APA, your instructor, or the Writing Center for help. After the following 

directions on how to organize each source, you will find an example reference list, which shows how your 

entries would look all together.  
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Dickson, M. (2009). Where there is no dentist: A book of 

methods, aids, and ideas for instructors at the village 

level (2
nd

 ed.). London, England: Hesperian 

Foundation. 

 

How to Create Reference List Entries 
 
A few important notes: 

 When writing the reference list, arrange all entries in alphabetical order. 

 Center the word References at the top; do not call it a ―Bibliography‖ or ―Works Cited.‖ 

 The entire page should be double spaced with no extra lines between entries. 

 The reference list should be a new page in the document, with header and page numbers 

continuing from the title page.  

 Note the hanging indent in APA style. That is, the second (+ third, fourth, etc.) lines of your 

entry are ―pushed in‖ or indented ½ inch (or 10 spaces). This makes it easier for the reader to see 

the first piece of information in the list. See the ―Using Microsoft Word 2007 for Formatting 

APA Essays‖ section at the end of the document for steps to set up a hanging indent. 

 While all major words (nouns, pronouns, verb, adjectives, adverbs and any word over four letters) 

are capitalized in the text of your essay, on the references list the rules for capitalization are 

different—pay close attention to individual examples to make sure you are capitalizing titles 

correctly based on the type of resource. 

 Web addresses are not used with the frequency once used in APA. When an entry calls for a web 

address, check if you need just the first part or the whole address. For an address that won‘t fit on 

one line, break it at a punctuation mark or forward slash. 

 Do not include retrieval dates. 

 

Reference List Examples: 

Books: 

One Author: 

Author‘s last name, first initial. (Date). Title and subtitle of book (also include edition if not the first). 

Place of Publication [city, state (or city, country if published outside the U.S.)]: Publisher Name. 

 

 

 

 

 

 

. 

 

 

 

Wright, J. (2009). Address unknown: The homeless in America. 

Piscataway, NJ: Aldine Transaction. 
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Two Authors: 

Same style as one author, except add a comma and ―& second author‘s last name, first initial.‖ after first 

author‘s name.  

 

 

 

 

 

 

 

Three or more Authors: 

First author‘s last name, first initial., Second author‘s last name, first initial., Third author‘s last name, 

first initial., & Fourth author‘s last name, first initial. (Date). Title of publication: Subtitle 

(Edition if not the first). Place of publication: Publisher‘s name.  

 

 

 

 

 

 

 

Note: When creating your in-text citation for a source with three or more authors, you should list all 

authors the first time, but afterwards it is appropriate to use the abbreviation ―et al.‖ (without the 

quotation marks, but always with the period; Latin for ―and others‖). Example: (Watson, et al., 2007, p. 

45). 

 

Article, Essay, or Chapter in an Anthology or Book with Editor: 

An anthology is a collection of essays or chapters written by a variety of authors and 

collected in a book by an editor. Make sure that you first list the author of the 

chapter or essay found in the anthology and not the editor of the book. The page 

range corresponds to the exact pages of the chapter/article in the book. 

 

Author‘s last name, first initial. (Date). Title of essay or chapter. In Editor‘s first initial. Editor‘s last 

name (Ed.), Title of book (pp. XX-XX). Place of publication: Publisher‘s name.  

 
Mangelsdorf, K., & Posey, E. (2003). Choices: A basic writing 

guide with readings. New York, NY: Bedford/St. Martin‘s. 

 

 

 
Watson, A., Jacobs, B., Jones, S., Reed, P., Sooner, N., & 

Kieffer, J. (2007). Pet therapy: New benefits of this 

frontier science. New York, NY: McGraw-Hill.  

 

 

 

! 
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Note: in the example above how, if there are multiple editors, their names are listed similarly to multiple 

authors, and ―(Ed.‖) becomes ―(Eds.)‖ following their names. 

 

Also note: the abbreviation before the page range in a reference list entry is ―pp.‖ rather than the single 

―p.‖ used in in-text citations to show the page number of a quotation. 

 

Two (or More) Works by the Same Author: 

Many times you will use more than one work by the same author. In such cases, cite the publications like 

normal with the earliest publication first. 

 Carmichael, C. (2007) . . . 

 Carmichael, C. (2009) . . . 

Personal Communication: 

Personal communications (emails, phone conversations, interviews you conducted) are 

not listed on the reference list unless they are retrievable from an archive, such as a letter 

held by a museum or library collections. APA does allow many online communications 

such as those found in network communities. See the APA (2010, 7.11) for an extensive 

list of accepted sources and corresponding formats on the reference list.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                              

 

Pamphlets & Newsletters: 

Citing a pamphlet is often compared to citing a book, but this can be difficult because much of 

the information cannot be found. Follow the general outline for a book, building in as much 

information as you can. Such publications will often have no author.  

 

 

Allison, D. (2001). Gun crazy. In L. Peterson, J. Brereton, & J. Hartman 

(Eds.), The Norton Reader (10
th
 ed.) (pp. 275-278). New York, NY: 

Norton. 

 

 

 

! 

! 
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Note: If the pamphlet is found online, see ―Internet with DOI‖ and ―Internet without DOI‖ in the 

following section on periodicals. 

Also note: when it is necessary to specify a date more specific than a year (in cases where there is no 

volume(issue) number and a publication is published more than once a year), list the year, month day as 

such: 2008, December 18. 

 

Periodicals: 

Print: 

Author‘s last name, first initial. (Date). Title of article. Name of Journal/Magazine, volume 

number(issue number), page range.  

 

 

 

 

 

 

Note: the volume number is italicized like the title, but the issue number is not. 

 

Online with DOI:  

New to the APA is the digital object identifier number (DOI). This number is assigned to articles in online 

databases to make it easier to locate articles, much like driver license numbers are used to track drivers in 

the U.S. Articles published in 2010 or after will likely have a DOI in major library databases such as 

EBSCO. If your citation has a DOI, cite it. If not, provide all the following information without the DOI. 

 

 

Puschendorf, L. (2006). Petroleum, politics, and prices: Omaha's gas war of 

1924. Nebraska History Quarterly, 87(2), 7-14. 

 

 
Domestic mistreatment of the elderly: Towards prevention. (2008, 

December). Garden Retirement Home Newsletter. Omaha, NE. 



29 

 

Author‘s last name, first initial. (Date). Title of article. Name of Journal/Magazine, volume number(issue 

number), page range. DOI: ############### 

 

 

 

 

 

 

 

 

Note: There is no period following a DOI or a URL (a web address) to avoid confusion that the period 

may be part of the DOI or URL (APA, 2010, 6.32). 

 

Online without DOI: 

Author‘s last name, first initial. (Date). Title of article. Title of Publication, volume number(issue 

number). Retrieved from http://www.xxxxxx.com 

 

 

 

 

 

 

Note: If a URL (web address) is too long to fit on one line, add a space to break it after a forward slash or 

before a punctuation mark. Do not add a period to the end of the URL. 

 

Periodical (Full Text) Accessed through Library Database with no DOI: 

If you have a DOI number, you only need to cite the DOI (APA, 2010, 7.01). If there is no DOI 

number, write the citation like a regular journal article and then add the URL of the database only 

in the following format: Retrieved from http://www.xxxxx.com (example: Retrieved from 

http://www.interscience.wiley.com). 

 

 
Danovitch, J. & Keil, F. (2004). Should you ask a fisherman or a biologist?: 

Developmental shifts in ways of clustering knowledge. Child 

Development, 75(3), 918-931. DOI: 10.1111/j.1467-8624.2004.00714 

 

 

 

  Koblitz, N. (1996). The case against computers in K-13 math education. The 

Math Intelligencer. Retrieved from http://www.math.washington.edu/ 

~koblitz/mi.html 

 

 

 

! 
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Author‘s last name, first initial. (Date). Title of article. Name of Journal/Magazine, volume number(issue 

number), page range. Retrieved from http://www.xxxxx.com 

 

 

 

 

 

Professional Website:  

Many professional websites will not provide key information that we commonly find with online 

newspapers, essays, and journal articles, such as the name of an author or the date of publication. In this 

case follow the basic outline, but always look for and cite as much information as possible. You may need 

to substitute information where appropriate, such as giving a corporate or organization name in place of 

an author (see ―Government or Corporate Publication‖ below).  

 

Author‘s last name, first initial or Organization name. (Date). Title of webpage. Title of website. 

Retrieved from http://www.xxxxx.com 

 

 

 

 

 

 

Lecture, Speech, or Presentation: 

Speaker‘s last name, first initial. (Date). Title of Speech. Speech or lecture presented at group or class 

name, Location. 

 

 

 

 

 
 Tucker, M. (2005). Varicella: Rates are dropping, but it still can kill. 

Pediatric News, 30(5), 12. Retrieved from http://www.galegroup.com 

 

 

 

 

Smith, J. (2008). Family communication: Homelessness. Lecture presented in 

Introduction to Family Communication at Southeast Community 

College, Lincoln, NE. 

 

 

 

 

 Worldwatch Institute. (2008). Ten ways to go green and save green. 

Worldwatch institute: Vision for a sustainable world. 

Retrieved from  http://www.worldwatch.org/resources/ 

go_green_save_green 
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Film: 

Producer‘s last name, first initial. (Producer), & Director‘s last name, first initial. (Director). (Year of 

release). Title of motion picture [Motion picture]. Country of origin: Studio or distributor.  

 

 

 

 

Government or Corporate Publication: 

Treat such documents as you would a book, with two additions: 1) a department publication identification 

number (if provided), and 2) a URL, if retrieved online. Cite reports generated by the federal U.S. 

Printing Office with the publisher location and name as such: ―Washington, D.C.: Government Printing 

Office‖ (without quotation marks) (APA, 2010, 7.03). 

 

Printed: 

Government Entity. (Date). Title (Department Publication Number). Place of publication: 

Publisher‘s name.  

 

 

 

 

 

 

Published Online: 

Government Entity. (Date). Title (Department Publication Number). Retrieved from 

http://www.xxxxx.com 

 

 

 

 

 

 

 

 LeRoy, M. (Producer), & Fleming, V. (Director). (1939). The wizard of Oz 

[Motion Picture]. USA: Metro-Goldwyn-Mayer.  

 

 

 

 

 

 

 

 
National Institute of Mental Health. (2003). Clinical training in the area of 

bi-polar clients (DHHS Publication No. MMA 80-1234). Lincoln, 

NE: U.S. Government Printing Office.  

 

 

 

 

 

 

 

 

 
U.S. Bureau of Justice Statistics. (2010). Identity theft reported by household 

2007 – Statistical tables (NCJ 230742). Retrieved from 

http://bjs.ojp.usdoj.gov/content/pub/pdf/itrh07st.pdf  
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The following is an example containing all the entries listed 

above as they would appear on the reference list: 

 

References 

Allison, D. (2001). Gun crazy. In L. Peterson, J. Brereton, & J. Hartman (Eds.), The Norton Reader (10
th
 

ed.) (pp. 275-278). New York, NY: Norton. 

Danovitch, J. & Keil, F. (2004). Should you ask a fisherman or a biologist?: Developmental shifts in 

ways of clustering knowledge. Child Development, 75(3), 918-931. DOI: 10.1111/j.1467-

8624.2004.00714 

Dickson, M. (2009). Where there is no dentist: A book of methods, aids, and ideas for instructors at 

the village level (2
nd

 ed.). London, England: Hesperian Foundation. 

Domestic mistreatment of the elderly: Towards prevention. (2008, December). Garden Retirement Home 

Newsletter. Omaha, NE. 

Koblitz, N. (1996). The case against computers in K-13 math education. The Math Intelligencer. 

Retrieved from http://www.math.washington.edu/~koblitz/mi.html 

LeRoy, M. (Producer), & Fleming, V. (Director). (1939). The wizard of Oz [Motion Picture]. USA: 

Metro-Goldwyn-Mayer.  

Mangelsdorf, K., & Posey, E. (2003). Choices: A basic writing guide with readings. New York, NY: 

Bedford/St. Martin‘s. 

National Institute of Mental Health. (2003). Clinical training in the area of bi-polar clients (DHHS 

Publication No. MMA 80-1234). Lincoln, NE: U.S. Government Printing Office.  

Puschendorf, L. (2006). Petroleum, politics, and prices: Omaha's gas war of 1924. Nebraska History 

Quarterly, 87(2), 7-14. 

Smith, J. (2008). Family communication: Homelessness. Lecture presented in Introduction to Family 

Communication course at Southeast Community College, Lincoln, NE. 

Tucker, M. (2005). Varicella: Rates are dropping, but it still can kill. Pediatric News, 30(5), 12. 

Retrieved from http://www.galegroup.com 

U.S. Bureau of Justice Statistics. (2010). Identity theft reported by household 2007 – Statistical tables 

(NCJ 230742). Retrieved from http://bjs.ojp.usdoj.gov/content/pub/pdf/itrh07st.pdf  

Watson, A., Jacobs, B., Jones, S., Reed, P., Sooner, N., & Kieffer, J. (2007). Pet therapy: New 

benefits of this frontier science. New York, NY: McGraw-Hill.  

Worldwatch Institute. (2008). Ten ways to go green and save green. Worldwatch institute: Vision for a 

sustainable world. Retrieved from  http://www.worldwatch.org/resources/go_green_save_green 

Wright, J. (2009). Address unknown: The homeless in America. Piscataway, NJ: Aldine Transaction. 
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Using Microsoft Word 2007 to Format APA Essays 

Learning to use a new word processing program can be stressful. Word 2007 has a new ―ribbon‖ system 

that lays out all the tools you‘ll need under categorized tabs, but all the rearranged icons in this new 

system can be intimidating. With a little practice, however, and the use of this step-by-step guide, you 

will be able to use Microsoft Word 2007 to format your APA essay. For those still using Word 2003, 

handouts are available in the Writing Center. 

  

Two notes before you get started:  

 The toolbar at the top of the screen is now called the Ribbon. The Ribbon contains each 

categorized tab and all the tool icons. 

 To save, print, or open a new document, click on the multi-colored, round Office Button 

found in the upper left-hand corner of the screen. 

 

Creating a Header—Method # 1 

1. On the ribbon, click the Insert tab. 

2. Click Header in the ―Header & Footer‖ group and 

select the first option in the list, ―Blank.‖ 

3. The header will appear at the top of the page. Type the 

running head  in the area that says 

―Type Text.‖ Be sure that the font 

size and type matches the rest of 

your essay. Make sure the running 

head is aligned with the left side of 

the page. 

4. Tab and space over to the right edge 

of the page.  

5. To insert the page number, click the Insert tab. Click Page 

Number, then ―Current Position.‖ Select the first option, 

―Plain Number.‖ The page number will appear on each page of 

your paper. 
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Creating a Header—Method # 2 

1. Click on the Insert tab. 

2. Click Page Number. 

3. Select Top of Page, then click 

the 3
rd

 option, ―Plain Number 

3.‖ 

4.  Type the running head before 

the page number and add 

enough spaces so that the 

running head is aligned with 

the left side of the page. 

 

Aligning Text 

1. Click on the Home tab. 

2. Look in the ―Paragraph‖ 

group for four alignment 

symbols. 

3. Use the guide below to 

move text as desired. 

 

 

 

 

 

How to View the Ruler 

1. Click on the View tab. 

2. In the ―Show/Hide‖ group, make sure 

that there is a check mark next to Ruler. 

3. The small icon on the far right of the  

ruler can also be used to show and hide 

the ruler. 

Align Text Left 

 
Center Align Text Right 

Justify 
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Using the Ruler—What Each Icon Means 

Using the ruler to create paragraph indents and hanging indents, rather than using the TAB key, will save 

you time and frustration when organizing paragraphs in your essay and indentations in your reference list. 

Review the following information about the Ruler, then follow the directions to create indents. Use the 

guide below to help identify the actions of each icon on the ruler. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

Creating a Paragraph indent or Hanging Indent—Method # 1 

You can, of course, just use the TAB key; however, using the formatting tools saves time in the long run. 

1. Before typing your reference list, go to the ruler, and drag the Hanging Indent button to the right 

to start a hanging indent. 

2. For APA, indent paragraphs and hanging indents by ½ inch. 

 

Paragraph Indent:             Hanging Indent: 

 

First Line Indent – 

click to drag just this 

marker by itself. 

Hanging Indent – shows 

where all but the first line 

in a paragraph is indented; 

click to drag just this 

marker by itself. 

Left Indent – click to 

drag all three markers at 

the same time. 

Right Indent Marker (on most 

college papers, this marker 

should stay in this position) 

Tab Alignment 

Button 
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Creating a Paragraph indent or Hanging Indent—Method # 2 

1. Before typing your reference list, click on the Page Layout tab. 

2. Under the ―Paragraph‖ group, click the little arrow in the lower, right corner to display the Paragraph 

Dialogue Box.  

3. Under the ―Indentation‖ section, click the box under the ―Special‖ category and choose First Line or 

Hanging. 

4. Choose ―OK‖ when finished. 

 

Changing the Default Line Spacing 

When you open Word 2007, you will notice that your page will have certain default settings that do not 

match APA standards. Some defaults (such as 

line spacing) can be confusing. Follow the 

directions below before you start writing to 

eliminate the extra spaces created by the default 

spacing: 

 

Step # 1 

1. Click on the Page Layout tab. 

2. Under the ―Paragraph‖ group, find ―Spacing.‖ 

3. Use the arrows in the box labeled ―After‖ to scroll down to ―0 pt.‖ 

Make sure the box labeled ―Before‖ is also set to ―0 pt.‖      

Step # 2 

1. Click on the Page Layout tab. 

2. Under the ―Paragraph‖ group, click the little arrow in the lower 

right corner to display the Paragraph Dialogue Box. 

3. Under the ―Spacing‖ section, click the box under the ―Line 

Spacing‖ category and choose double. 

4. Click OK. 
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Saving Your Essay as an .RTF File 

RTF stands for Rich Text Format. RTF is a universal text format that will give you the ability to open 

your essay on any computer with any word processing program. It is also important to note that saving as 

RTF ensures that others (such as your instructor or Smarthinking tutors) will be able to access your essay, 

too. When saved correctly, your essay will have an 

.RTF extension; for example: Essay1.rtf. Follow 

the directions below to save your essay as an RTF 

file: 

 

1. Click on the Office Button, found in the 

upper left-hand corner of the screen. 

2. Click on Save As. A new box will open, 

then choose ―Other Formats.‖ 

3. Choose where on the computer you want to 

save your file, then type in the name you 

want to give your file. 

 

 

4. Click the bottom box, Save as Type and choose Rich Text Format from the list. 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Click OK to finish. 
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Changes to the 6
th

 Edition of the APA 

The newest APA contains several changes. The most significant is the recognition of Internet usage in 

research as well as the use of the DOI system demonstrated in this handout. For a detailed list of other 

changes go to http://www.apastyle.org/manual/whats-new.aspx  

 

You will also find the apastyle.org site a useful resource in developing your APA style paper.  

If you have any other questions 
about APA, please feel free to visit or 

call the SCC Writing Center:  
(402) 437-2627 or 

www.southeast.edu (Quicklinks  
Student Services  Tutoring) 
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